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1. Introduction 
1.1 About MaSK 
Molecular Modeling and Simulation Kit (MaSK) is the software that is useful in the visualization of 
various molecular properties calculated by either GAMESS or Gaussian® computational 
chemistry programs. MaSK can also be used to create, modify and set options for the PC GAMESS 
input files. The user will also be able to run the PC GAMESS job and control its execution without 
leaving the MaSK interface.  

Key features of MaSK include ability to:  

General: 

 Read 4 formats: GAMESS output, GAMESS input, Gaussian output, and Gaussian input  
 Visualize molecules in 4 styles: balls and sticks, spheres, tubes, and wireframe  
 Choose between orthographic and perspective view  
 Show/hide hydrogen bonds, atom names and numbers  
 Visualize coordinate axes  
 Measure distances, angles, dihedral angles, and angles between planes (and monitor 

their changes during optimization)  
 Save images as JPEG, GIF, BMP or PNG graphics files  
 Copy image to the clipboard to paste in other application  
 Modify input geometry as Z-matrix (including automatic and manual atom addition or 

automatic functional group addition) or Cartesian coordinates  
 Set input options for GAMESS job and save as GAMESS Input file  
 Submit GAMESS (PC GAMESS version) job from within the MaSK  
 Check the status of a PC GAMESS calculation  
 Terminate PC GAMESS calculation  

Results:  

 Visualize all steps of optimization as a movie or step-by-step  
 Visualize all optimized points of the Intrinsic Reaction Coordinate (IRC) following  
 Visualize calculated Mulliken (GAMESS and Gaussian) and Lowdin (GAMESS) charges  
 Visualize vibrational modes as animation or as vectors  
 View optimization energy graph (SCF-only energies for Gaussian output)  
 Visualize dipole direction  
 Visualize molecular orbitals with multiple options  
 Visualize electron and spin densities  
 Visualize molecular electrostatic potential plotted onto the electron density  
 Show brief or extended summaries of the results  
 Export Potential Energy Surface scan results from GAMESS calculations to CSV file 

format for use in spreadsheet applications  
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Customization: 

 Change text size and color  
 Change background color  
 Choose maximum resolution of the saved images  
 Choose to draw/hide metal-metal bonds  
 Choose to draw/hide metal-nonmetal bonds  
 Change the speed of rotation of the molecule, vibrations, and animation of optimization 

steps  
 Change atomic parameters for any atom: 

1) Atomic radius 
2) Van der Waals radius 
3) Atom color  

 Modify radius and color of covalent and hydrogen bonds as well as opacity of hydrogen 
bonds.  

1.2 Using MaSK with GAMESS 
GAMESS (The General Atomic and Molecular Electronic Structure System) is a general ab initio 
quantum chemistry package. There are several different version of GAMESS developed by 
different groups of researchers (e.g GAMESS-US, GAMESS-UK, etc.). MaSK was specifically 
developed with the support for PC GAMESS. 

PC GAMESS is a freely available ab initio and DFT computational chemistry program developed 
to offer high performance on Intel-compatible x86, AMD64, and EM64T processors. It was initially 
based on the free GAMESS-US program sources but extends its functionality in some important 
areas. The PC GAMESS project is maintained by the staff of the Laboratory of Chemical 
Cybernetics at Moscow State University (MSU). The project coordinator and leading developer is 
Dr. Alex A. Granovsky. PC GAMESS can be obtained free of charge after registration from 
http://classic.chem.msu.su/gran/gamess. 

The versions of GAMESS other than PC GAMESS can be read in most cases. However, the 
functionality of MaSK can be limited when working with unsupported versions of GAMESS. 

GAMESS has a large number of options that control the type of calculations, properties being 
calculated and the amount of data the user wants to see in the output. It is recommended that 
when searching for optimal geometry or saddle point users do not use values -1 or -2 for the key 
NPRT in the $STATPT group in GAMESS input as this turns off the printing of molecular orbital 
coefficients needed for molecular orbital visualization in MaSK. If a user creates GAMESS input 
file in MaSK, this option is automatically left at its default value (0). 

PC GAMESS input files can be created from within MaSK. User can select from many built-in 
options such as run type, level of theory, SCF type, etc. Since GAMESS supports a very large 
number of options, the MaSK includes only a subset of those options. If the desired option(s) is 
not available in the options section, user can add/modify such option(s) manually in the created 
input file. 

If the PC GAMESS is installed on the computer, user can submit the calculations, check the 
status of calculations, and read the results without ever leaving MaSK. 
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1.3 Using MaSK with Gaussian® 
Gaussian® is a commercial electronic structure program and is available from 
http://www.gaussian.com. Gaussian is used by chemists, chemical engineers, biochemists, 
physicists and others for research in established and emerging areas of chemical interest.  

Starting from the basic laws of quantum mechanics, Gaussian predicts the energies, molecular 
structures, and vibrational frequencies of molecular systems, along with numerous molecular 
properties derived from these basic computation types. It can be used to study molecules and 
reactions under a wide range of conditions, including both stable species and compounds which 
are difficult or impossible to observe experimentally such as short-lived intermediates and 
transition structures. 

The MaSK is able to read and visualize multiple calculated properties from the Gaussian output 
file. However, the molecular energies shown by MaSK (optimization graph and results 
summaries) are the SCF energies. If the level of theory of performed calculations is other than 
Hartree-Fock or Density Functional Theory, the user is instructed to manually inspect the output 
file to find the final energy or energies at each optimization step at the desired level of theory. 

Only the molecule's geometry can be read from the Gaussian input file; all Gaussian directives 
are omitted when reading the file. If the input file contains several jobs (separated with --Link1-- 
directive, only the first one will be read). Even though reading Gaussian input file is supported, 
the input file cannot be saved. Therefore, if user needs to modify and save the molecule read 
from the Gaussian input file, it may be converted to GAMESS input  or the modified geometry 
may be exported in a form of Cartesian coordinates  into a text file. 

It is recommended to use the following options in the Route (#) section of Gaussian input: 
1. GFInput to print basis set 
2. Pop=Full (or Pop=NaturalOrbitals) to print molecular orbital coefficients 
Without the above options, MaSK will not be able to visualize molecular orbitals, electron and 
spin densities, and molecular electrostatic potential. 

2. Menus and Toolbars 
2.1 Menus 
The program has 7 popup menus in the top-level menu. They are 

1. File 
2. Edit 
3. View 
4. Molecule 
5. Results 
6. Calculate 
7. Help 
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Figure 2.1. File menu. 

The File menu (Fig. 2.1) has the following options: 

1. New: Create a new GAMESS Input file 
2. Open: Open existing supported file 
3. Close: Close opened file 
4. Save: Save opened GAMESS Input file (disabled for other file types) 
5. Save As...: Save file as GAMESS Input 
6. Save Image As...: Save screen image to JPEG, GIF, PNG, or BMP file 
7. Export Cartesians...: Export geometry as Cartesian coordinates into a text file 
8. Print...: Print screen image 
9. Print Preview: Show a preview of the printed image on screen 
10. Print Setup...: Set the printer and its options. 
11. Five most recently opened files 
12. Exit: close the program  

 
Figure 2.2. Edit menu.  

The Edit menu (Fig. 2.2) has the following options: 

1. Copy to Clipboard: Copy the screen image to clipboard for later insertion in another application 
2. Add Atoms/Groups: Open a dialog to add atoms or groups of atoms 
3. Modify Geometry: Open a dialog to modify molecule's geometry in form of Z-Matrix or 
Cartesian coordinates 
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4. Auto Resize/Recenter: Resize the molecule to fit in the screen and recenter in the window 
(useful when adding atoms) 
5. Preferences: Modify program preferences 

 
Figure 2.3: View menu. 

The View menu (Fig. 3) allows user to control which of the toolbars and whether the status bar 
are visible on the screen. By highlighting the Toolbars option, the new popup menu will show 
available toolbars and the checkmarks indicate which of them are currently visible. 
Selecting/deselecting a particular toolbar will show/hide this toolbar. Reset Toolbars option allows 
to reset the positions of all toolbars to their default locations and sets them all to visible state. 

 
Figure 2.4. Molecule menu.  

The Molecule menu (Fig. 2.4) contains options relevant to the way the molecule is drawn and 
manipulated on the screen. The following options are available: 

1. Balls & Sticks: Show atoms as balls and bonds as sticks 
2. Spheres: Show atoms as space-filling spheres 
3. Tubes: Show molecules as tubes 
4. Wireframe: Show molecules in form of thing wires 
Note: Only one option (1-4) can be selected at a time. 

5. Show Hydrogen Bonds: Show/hide hydrogen bonds if present 
6. Show Atom Symbols: Show/hide Atomic labels 
7. Show Atom Numbers: Show/hide the number of each atom in the molecule 
8. Show Coordinate Axes: Show/hide the coordinate axes (useful in building/modifying a 
molecule) 
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9. Perspective View: Show molecule in perspective projection (parts of the molecule that are 
closer to the viewer appear larger) 
10. Orthographic View: Show molecule in orthographic projection (all parts of the molecule have 
the same size regardless of the distance from the viewer) 
Note: Only one option (Perspective or Orthographic) can be selected at a time. 

11. Hold & Pull Mouse: Use a sticky-type mouse pointer (selected) or a regular one (deselected). 
(See Molecule manipulation  the for more details on this option)  

 
Figure 2.5. Results menu.  

The Results menu (Fig. 2.5) contains the options to visualize various calculated properties. When 
a particular property has not been calculated or has not been properly read from the output file, 
the corresponding option in the Results menu will be disabled. All options in this menu are 
disabled for input files. Available options include: 

1. Brief Summary: Show a summary of results such as type of calculation, level of theory, basis 
set, final energy, etc. 
2. Extended Summary: Show more information from the output by adding energies at each step 
of geometry optimization, thermochemical data and calculated charges (if calculated) to the brief 
summary. 
3. View Output (in Notepad): Open the output file in the Notepad text editor 
4. Calculated Charges: Choose to show/hide Mulliken or Lowdin calculated charges on atoms 
5. Optimization Energy Graph: Show the graph with relative energies at each step of geometry 
optimization 
6. Calculated Vibrations: Show a dialog controlling the visualization of calculated molecular 
vibrations 
7. Show Dipole Direction: represents the direction of the calculated dipole moment in the 
molecule (absent if 0) 
8. Show Molecular Orbitals: Open a dialog to control the visualization and calculation of molecular 
orbitals 
9. Show Electron/Spin Density: Open a dialog to control the visualization and calculation of 
electron or spin density   
10. Show Electrostatic Potential: Open a dialog to control the visualization and calculation of 
molecular electrostatic potential (MEP) 
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Figure 2.6. Calculate menu. 

The Calculate menu (Fig. 2.6) allow the user to change the GAMESS Input file options, submit a 
calculation to the PC GAMESS (if installed) and show/terminate any running GAMESS 
calculation. 

 
Figure 2.7. Help menu. 

The Help menu (Fig. 2.7) allows to run MaSK help and show the program information. 

2.2 Toolbars 
There is one status bar and 6 toolbars that can be shown or hidden through View menu (fig. 3) or 
by clicking with the right button of the mouse anywhere within the toolbar region. Some of the 
toolbars (all except Animation and Measuring) are the shortcuts to some of the menu options 
described previously in the Menu section. The following toolbars are available: 

1. Standard 
2. Animation 
3. Formatting 
4. Measuring 
5. Editing 
6. Results 

 
Figure 2.8. Standard toolbar.  

The Standard toolbar (Fig. 2.8) contains shortcuts to creating a new GAMESS Input file, opening 
existing file, saving opened GAMESS Input file and converting current file into new GAMESS 
Input file, printing image and Help.  

 
Figure 2.9. Animation toolbar.  

The Animation toolbar (Fig. 2.9) allows user to visualize all step of geometry optimization (if 
performed). The actions of each button are following: 

1. Rewind to the initial geometry 
2. Move to the previous geometry 
3. Play all geometries in succession (turns into Stop button when activated) 
4. Move to the next geometry 
5. Fast forward to the last geometry 
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Figure 2.10. Formatting toolbar.  

The Formatting bar (Fig. 2.10) allows user to zoom in or zoom out the molecule on the screen, as 
well as select the format of molecule presentation from Balls and Sticks, Spheres, Tubes, and 
Wireframe (see Molecule menu above). The last button allows to select/deselect the Hold & Pull 
Mouse option. 

 
Figure 2.11. Measuring toolbar.  

The Measuring toolbar (Fig. 2.11) allows the user to perform some measurements within a 
molecule. The actions of each button are following: 

1. Clear all atom selections (e.g., from previous measurement). 
2. Measure interatomic distance (need to select 2 atoms) 
3. Measure angle (need to select 3 atoms) 
4. Measure diherdal angle (need to select 4 atoms) 
5. Measure interplanar angle (need to select 3+3 = 6 atoms where each triplet of points defines 
one plane). 

 
Figure 2.12. Editing toolbar.  

The Editing toolbar (Fig. 2.12) provides shortcuts to 3 options from the Edit menu (see above): 
Add Atoms/Groups, Modify Geometry, and Auto Resize/Recenter. 

 
Figure 2.13. Results toolbar.  

The Results toolbar (Fig. 2.13) provides shortcuts to 5 options from the Results menu (see 
above): Optimization Energy Graph, Calculated Vibrations, Show Dipole Direction, Show 
Molecular Orbitals, and Show Electron/Spin Density. 

 
Figure 2.14. Status bar. 

The Status bar at the bottom of the window (Fig. 2.14) provides information about which step 
optimization is currently visualized (if optimization has been performed) or reads Single-Point 
Calculation (if only one geometry was found in the file). 
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3. Molecule Visualization and 
Manipulation 
3.1 Opening and Saving a File 

In order to open an existing file, click on the button on the Standard toolbar or select option 
Open from the File menu and then choose the file you want to open. If you want to save a file 
under a different name (available for GAMESS Input only), choose option Save As... from the File 

menu. To save a modified GAMESS Input file, press the button. 

When the molecule is initially opened, it's size and position on the screen are are automatically 
adjusted by the program to maximize the molecule's view on the screen: molecule's size is set to 
fill most of the screen and it's orientation is such that most of the atoms are visible on the screen. 
The optimal initial orientation of the molecule on the screen is calculated only for molecules with 
50 atoms or less. 

3.2 Changing Molecule's Visualization Mode 
If this is the first time you run MaSK, the molecule will be shown in its default Balls and Sticks 
visualization mode. Otherwise, the molecule will be shown in the mode that was selected in the 
last run of MaSK. 

There are four molecule visualization modes available: Balls and Sticks, Spheres, Tubes and 
Wireframe. Each one can be selected through either a Molecule menu or by pressing a 
corresponding button on a Formatting toolbar . 

In Balls and Sticks mode, the atoms are presented as solid balls and bonds are presented as 
sticks. The radius of each ball depends on the atomic radius, which together with the radius of the 
bond (stick) can be modified in Preferences. In the Spheres format, the atoms are presented as 
spheres whose radii depend on the Van der Waals radii that can be modified in Preferences . 
When Tubes format is chosen, molecules are presented in the form of tubes whose ends and 
intersections represent atoms. The radii of the tubes for this format can also be modified in 
Preferences . Finally, the Wireframe format is similar to the Tubes but lines are used instead of 
tubes.  

3.3 Showing Additional Information 
In addition to atoms and bonds visualized on the screen, user may choose to show/hide hydrogen 
bonds, atomic symbols and numbers. The coordinates axes may also be visualized. All these 
options are available from the Molecule menu . 
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3.4 Zooming In/Out 
The currently visualized molecule can be zoomed in (up to 200% view) or out (down to 25% view) 
using 3 methods: 
1. Choose the zoom level directly from the Zoom drop down menu on the Formatting toolbar . 
2. Press button to zoom in or button to zoom out on the Formatting toolbar . 
3. Turn the mouse wheel (if present) towards you to zoom out or away to zoom in.  

3.5 Measuring 
There are four measuring tools available to user: distance between atoms, angle defined by 3 
atoms, dihedral angle defined by 4 atoms, and interplanar angle defined by 6 (3+3) atoms. All 
these tools are available on the Measuring toolbar .  

1. Measuring distance. Press button to measure the distance between two atoms (mouse 
cursor will turn into cross hair). Then, select two atoms in the molecules by clicking on the desired 
atoms. Selected atoms will be colored yellow. 

2. Measuring angle. Press button to measure the angle (mouse cursor will turn into cross hair) 
and then select 3 atoms. The selected atoms will be colored yellow. 

3. Measuring dihedral (torsion) angle. Press button (mouse cursor will turn into cross hair) and 
then select 4 atoms in a molecule. The selected atoms will be colored yellow. 

4. Measuring interplanar angle. Press button (mouse cursor will turn into cross hair) and 
select 3 atoms that define the first plane and then select 3 more atoms to define the second 
plane. All atoms must be unique. The selected atoms will be colored yellow. 

After the required number of the atoms have been selected, the mouse cursor will return to the 
original state and the computed value will be displayed in the lower left corner of the window. To 
clear the selection, measured value or to cancel the measurement at any time, press the clear 
button ( ) on the Measuring toolbar. 

3.6 Molecule Manipulation 
There are two ways to manipulate the molecule on the screen: using a mouse or keyboard. 

There are 4 directional buttons on the keyboard that can be used to rotate the molecule up, down, 
left and right. The speed of rotation is slower that that for the mouse for a better precision. 

There are two modes of using a mouse: regular and Hold & Pull. The modes can be switched by 

either pressing the button on the Formatting toolbar or selecting Hold & Pull mouse from the 
Molecule menu . 

Regular Mode. With regular mode the screen is virtually divided into 9 equal squares (3 x 3). 
Pressing the left mouse button while keeping pointer in one of the squares (except the central 
one) rotates the molecule in that direction until the button is released. The central square is 
further divided into 4 triangles: top, bottom, left and right. Pressing the mouse button while 
keeping the mouse pointer in one of the triangles will rotate the molecule in the corresponding 
direction. The molecule can also be rotated clockwise on the screen if the right mouse button is 
pressed.  
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Hold & Pull Mouse Mode. In this mode, when the mouse is being moved while the left button 
pressed, the molecule is rotated in the direction of the mouse movement. In addition, pressing the 
right mouse button and moving mouse left or right allows to rotate the molecule counter- or 
clockwise, correspondingly.  

4. Working with Output Files 
4.1 Visualization of Optimization 
If the output file contains more than one geometry as in geometry optimization, saddle point 
localization or Intrinsic Reaction Coordinate (IRC) following, then all of the steps can be 
visualized as single steps or as an animation. When the output with multiple steps if first open, 
either first (starting) or the last (optimized, if normally terminated) geometry is displayed 
depending on the user selection in Preferences. The step number and the total number of 
geometries in the output file are displayed in the MaSK status bar . The selection of the geometry 
to be visualized is done through the Animation toolbar  or Optimization Energy Graph (see 
below).  

There are five buttons available on the Animation toolbar: First ( ), Previous ( ), Animate (
), Next ( ), and Last ( ). The First button causes the first geometry to be visualized (disabled if 
currently visualized geometry is the first one). The Last button causes the last geometry to be 
visualized (disabled if currently visualized geometry is the last one). The Previous and Next 
buttons go one step back or forward in the list of available geometries and are disabled if the first 
or last geometry are currently visualized, correspondingly. Finally, the Animate button causes to 
display all geometries (starting with the currently visualized) for a short duration until reaching the 
end. The duration of the display of each geometry can be customized in Preferences. 

Note: for IRC calculations only optimized points on the reaction coordinate will be visualized for 
clarity.  

The relative energies of each intermediate and final geometries can be compared by pressing the 
button on the Results toolbar  or selecting the optimization Energy Graph from the Results 

menu  (Figure 4.1). Holding a mouse pointer over one of the columns representing the relative 
energies of each step will display the step number and the energy (in Hartree) for that step 
(Figure 4.2). In addition, left-click over any step in the graph will immediately visualize the 
selected step in main window. The full height of the diagram represents the difference between 
the largest and the smallest energy values among all steps.  

Note: The visualized energies for Gaussian outputs are the SCF energies. If the calculations have 
been performed at the level other than Hartree-Fock or Density Functional Theory (DFT), consult 
the output file to locate the energies at the chosen level of theory.  
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Figure 4.1. Relative energy diagram (under Windows XP). 

 
Figure 4.2. Relative energy diagram with mouse pointer (not shown) resting over second column 
(under Windows Vista). 

4.2 Visualization of Molecular Properties 

4.2.1 Dipole Moment 

If the dipole moment has been correctly read from the output and the value is larger than 0, it can 
be visualized by pressing button on the Results toolbar or selecting Show Dipole Direction 
from the Results menu . Since the dipole shown is the one calculated for the last geometry (if 
more than one found), the last geometry will be visualized when this option is engaged.  

4.2.2 Mulliken and Lowdin Charges 

Calculated charges can be visualized by going to the Results menu and then Calculated 
Charges. Two options are available: Mulliken (Gaussian and GAMESS) and Lowdin (GAMESS 
only). These will show charges on each atom calculated according to Mulliken or Lowding 
scheme, correspondingly. To hide charges, follow the same steps and deselect the currently 
displayed charges. Note: if the option is disabled, then the charges were either not calculated or 
not read correctly.  
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4.2.3 Molecular Orbitals 

The molecular orbitals can be visualized by MaSK only if both atomic basis set and molecular 
orbital coefficients have been printed in the output file (see Using MaSK with GAMESS and Using 
MaSK with Gaussian for details). To open the Molecular Orbitals window, press the button on 
the Results toolbar or select Show Molecular Orbitals from the Results menu . Note: the option 
will be disabled if either atomic basis set or molecular orbital coefficients have not been found in 
the output file.  

Note: When Orbitals window is open, the molecule format will be switched to Wireframe (can be 
changed after opening) for better visualization (especially for small orbitals, which can be hidden 
by the objects in other formats (i.e., balls, spheres, etc.). If the output contains more than 1 
geometry, then the last geometry will be visualized in the main window and Animation toolbar 
buttons will be disabled (so that the orbitals calculated for the last geometry would not be mapped 
on the wrong geometries).  

Figure 4.3 below shows a sample Molecular Orbitals window. 

 
Figure 4.3. Molecular Orbitals window.  

There are several items and options shown in the Molecular Orbitals window: orbital list, 
isosurface value, surface type, orbital localization speed, surface points setting (and its 
suboption). Orbital list contains 4 columns: orbital number, spin, eigenvalue and occupancy. Spin 
values can be A (alpha), B (beta), and AB (combined alpha and beta) and indicate the spin of 
electron(s) on that orbital. Separate alpha and beta spins are available with unrestricted 
wavefunctions only. Occupancy show the number of electron occupying a particular orbital. The 
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list is sorted from lowest to highest eigenvalues. To visualize an orbital, simply click on a 
corresponding line in the list.  

Note: To display the Highest Occupied Molecular Orbital (HOMO), select from the list the last 
orbital that has at least 1 electron on it (e.g., orbital #5 in Figure 4.3). To display the Lowest 
Unoccupied Molecular Orbital (LUMO), select from the list the first orbital without electrons (i.e., 
with 0 in the Occupancy column; e.g., orbital #6 in Figure 4.3).  

Isosurface value allows to visualize the surface with a particular value of the wavefunction. The 
default isovalue is 0.01.  

Surface type has three options: Dots (surface is represented as a series of points), Mesh (surface 
is represented as a series of lines connecting the points), and Solid (a solid surface is built). 
When Solid surface type is selected, an Opacity option will be shown at the bottom of the window 
that allows to change the opacity from completely transparent to completely opaque. Note: due to 
the nature of OpenGL transparency, some orbitals may not be visible through others and hidden 
sides of complex orbitals may be displayed incorrectly in a semitransparent mode.  

Orbital localization allows to find the edges of the imaginary cube within which all orbital surface 
points are located. This, in turn, allows to not waste points for the space which is far from the 
actual orbital resulting in a smoother surface with smaller number of points. In order to localize 
the orbital, an initially large cube is chosen based on the coordinates of the atoms and then each 
side of it is moved inward step-by-step until the surface is intersected. With a Fast (default) or 
Medium options selected, MaSK first makes large steps, finds the edge of the orbital, steps back 
and then makes smaller steps to locate the orbital. With Slow option MaSK moves each side of 
the cube in small steps only. In addition, in Slow mode MaSK uses the same number of points 
per axis as in the final cube, while only half of the points is used in Fast and Medium modes.  

Note: Fast option is appropriate for most orbitals. However, if after the calculation of the orbital is 
complete no orbital is displayed in the main window or the orbital has holes, then the orbital may 
be too small and was skipped due to very large steps or inadequate number of points selected. 
To correct this, either choose one of the better (albeit slower) Orbital localization options and/or 
increase the Number of points (see below).  

Surface points set by allows to select the number of points that will be used for orbital 
visualization. More points (or less point spacing) increases the quality of the calculated orbital 
surface but significantly increases the time required for computations. The tree options available 
are Number, Spacing, and Quality. If the points are set by Number, then the number of points per 
axis need to be selected. The default value is 40 points per axis. If the points are set by Spacing, 
then the spacing between points (in angstroms) needs to be selected. The default spacing is 0.10 
angstrom. Finally, if the Quality option is selected, then the cube quality is defined by the number 
of points per angstrom. Options available for this type are Coarse, Medium, and Fine with 5, 10, 
and 20 points per angstrom, correspondingly.  

Recalculate/Redraw button is needed only in the following two cases. 1. If the user changes 
some parameters described above and wants to redraw the currently visualized/selected orbital 
with new options. 2. If the orbital has been loaded from MaSK Cube File (for more on this, see 
Molecular Orbital Data in Preferences ) and the user wants to recalculate it with new options.  

When new orbital is chosen for visualization or Recalculate/Redraw button is pressed, a progress 
bar will become visible below the Recalculate/Redraw button showing the progress of the orbital 
localization and calculation of the wavefunction values. The calculations may be cancelled at any 
time by pressing ESC button on the keyboard. 
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4.2.4 Electron and Spin Densities 

The electron and spin densities can be visualized by MaSK only if both atomic basis set and 
molecular orbital coefficients have been printed in the output file (see Using MaSK with GAMESS 
and Using MaSK with Gaussian for details). To open the Electron and Spin Density window, 
press the button on the Results toolbar or select Show Electron/Spin Density from the Results 
menu . Note: the option will be disabled if either atomic basis set or molecular orbital coefficients 
have not been found in the output file.  

Note: When Electron/Spin Density window is open, the molecule format will be switched to 
Wireframe (can be changed after opening) for better visualization. If the output contains more 
than 1 geometry, then the last geometry will be visualized in the main window and Animation 
toolbar buttons will be disabled (so that the density calculated for the last geometry would not be 
mapped on the wrong geometries).  

Figure 4.4 below shows a sample Electron/Spin Density window. 

 
Figure 4.4. Electron/Spin Density window. 

The options available in the Electron/Spin Density are mostly the same as in the Molecular 
Orbitals window (see above). Select Electron density or Spin density radio button in the Type 
group to build electron or spin density, correspondingly. See the description of the other options 
available (Isosurface value, Surface type, etc.) in the Molecular Orbitals section.  

After all options have been set, press the Calculate/Draw button to calculate and draw the 
selected density. The progress bar will show the current progress in localizing density, calculating 
density values and drawing surface (press ESC at any time to cancel the operation). 

If the electron or spin density has been previously saved to the MaSK Cube File and current user 
setting is to Save Calculated Cube Data to File (for more on this, see Molecular Orbital Data in 
Preferences ), the data will not be calculated and will be loaded from the file. If you want to force 
the new calculation, check the Recalculate surface option below the Calculate/Draw button and 
press the latter.  
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4.2.5 Molecular Electrostatic Potential 

The Molecular Electrostatic Potential (MEP) can be mapped onto electron density and visualized 
by MaSK only if all three of the following data is printed in the output file: 1) atomic basis set, 2) 
molecular orbital coefficients, and 3) Mulliken atomic charges  (see Using MaSK with GAMESS 
and Using MaSK with Gaussian for details). To open the Molecular Electrostatic Potential 
window, select Show Electrostatic Potential from the Results menu . Note: the option will be 
disabled if any of the aforementioned data have not been found in the output file.  

Note: When Electrostatic Potential window is open, the molecule format will be switched to 
Wireframe (can be changed after opening) for better visualization. If the output contains more 
than 1 geometry, then the last geometry will be visualized in the main window and Animation 
toolbar buttons will be disabled (so that the density calculated for the last geometry would not be 
mapped on the wrong geometries).  

Figure 4.5 below shows a sample Electrostatic Potential window. 

 
Figure 4.5. Electrostatic Potential window.  

Since the electrostatic potential is mapped on the electron density surface, you must select the 
isovalue for that surface. For the description of available options see Electron and Spin Densities 
and Molecular Orbitals sections. 

After the MEP is displayed, the color scale with the smallest, medium and largest values of the 
potential (in electron2/Bohr) is displayed in the lower-left corner of the main window. 

If the electron density with the same isosurface value as currently selected has been previously 
saved to the MaSK Cube File and current user setting is to Save Calculated Cube Data to File 
(for more on this, see Molecular Orbital Data in Preferences ), the electron density will not be 
calculated and will be loaded from the file. If you want to force the new calculation of the density, 
check the Recalculate surface option below the Calculate/Draw button and press the latter.  
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4.3 Visualization of Molecular Vibrations 
If the calculations of the vibrational frequencies have been performed and the results have been 
printed in the output file, they can be visualized in MaSK by either pressing button on the 
Results toolbar or selecting Calculated Vibrations from the Results menu . Both the button and 
the menu option will be disabled if the vibrational frequencies have not been found in the output 
file.  

After the is pressed or Calculated Vibrations menu option is selected, a Vibrations window 
(see Figure 4.6) will be open. 

 
Figure 4.6. Sample Vibrations window. 

The Mode window contains all calculated harmonic vibrational frequencies (in cm-1) and 
corresponding IR intensities (KM/Mole, Gaussian; Debye2/amu-Angstrom2, GAMESS). The list is 
sorted by increasing frequency value. Selecting any mode in the list will display the corresponding 
vibrational mode in the main window with either animation (if Visualization Type is set to 
Animation) or vectors (if Visualization Type is set to Vectors). 

Note: It is recommended to switch to Wireframe molecular format when visualizing vibrations in 
the form of vectors as some vectors may be hidden by balls/spheres representing atoms and/or 
cylinders representing bonds.  

The amplitude of the animated vibration or the size of the vector can be increased or decreased 
by sliding the Amplitude control to the right or to the left of the center. The rate of the animated 
vibration can be regulated through the Rate of Vibration in Preferences. 
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4.4 Viewing Result Summaries 
Instead of searching for basic information through the output file, Result Summaries (brief and 
extended) can provide most of the required data in a concise form. To view the summary, select 
Brief Summary (or Extended Summary) from the Results menu . 

Brief summary provides the following information: type of calculations, method, basis set, 
stoichiometric formula, number of atoms in the molecule, multiplicity, charge, dipole moment, final 
energy (except for IRC calculations). In addition, for geometry optimization and saddle point 
(transition state) localization calculations, the number of steps will be printed with the information 
whether the optimization/localization was completed. 

Extended summary adds the following information to the brief summary where calculated: 
thermochemical data (temperature, zero-point energy (ZPE), entropy, total electronic and thermal 
energy, enthalpy and Gibbs free energy, etc.), energy for each step of optimization/saddle point 
localization/IRC following, calculated Mulliken (GAMESS and Gaussian) and Lowdin (GAMESS) 
charges for all atoms, potential energy surface scan results (GAMESS only). 

4.5 Exporting PES Scan Result (GAMESS) 
Results of the Potential Energy Surface (PES) scan performed by GAMESS can be exported to 
the Comma-Separated Values (CSV) file for further use in the graph-building capable software 
(e.g., Microsoft Excel). When PES scan results are detected in GAMESS output, an extra option 
Export PES Results... will be added at the bottom of the Results menu . Selecting this option will 
bring up a dialog to select a file name and location for the CSV file. Note: only completed PES 
scan results can be exported. 

5. Converting Output to Input 
Unless the file opened is GAMESS input, the geometry cannot be modified and saved (Gaussian 
input can be modified but cannot be saved). Converting the file into GAMESS input allows user to 
modify geometry and save it. Gaussian input, Gaussian output and GAMESS output files can be 
easily converted to GAMESS input in several ways: 

1. If working with Gaussian input or single-point GAMESS/Gaussian output calculations, user can 
convert it to GAMESS Input by pressing button or save a file as GAMESS Input by choosing 
Save As... from File menu. 

2. If working with GAMESS or Gaussian output files containing several geometries (e.g., 
geometry optimizations), then select the geometry that you want to modify (e.g., by visualizing the 
desired optimization step) and after that convert it to GAMESS Input by pressing button or 
save that geometry as GAMESS Input by choosing Save As... from File menu. 

In both cases the default GAMESS input option will be given to the newly created input files. 
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6. Working with Input Files 
Only GAMESS Input files can be modified. See Converting Output to Input section on instructions 
about converting other formats into GAMESS Input.  

Note: when no file is open or New button is pressed on the Standard Toolbar , the file format is 
automatically set to GAMESS Input.  

All geometry modification options are accessed through three buttons on the Editing Toolbar . 
The functions of these buttons are Add atoms ( ), Modify geometry ( ), and Reset molecule's 
size/position ( ). The latter simply resizes and repositions the molecule such that its center 
coincides with the center of the window and all atoms fit in the MaSK window and is useful when 
building a new molecule or adding atoms or groups to existing one.  

In addition to adding atoms or modifying geometry, user can also set/change GAMESS input 
options and run GAMESS calculations without leaving MaSK. 

You may 

1. Modify geometry 
2. Add atoms 
3. Add groups of atoms 
4. Set GAMESS input options 
5. Run GAMESS calculations

6.1 Modifying Geometry 
The geometry of any molecule can be given by different means of which most common are Z-
Matrix and Cartesian coordinates. Z-Matrix defines a molecule through an atomic connectivity or 
simply their positions relative to other atoms. For example, every atom (except the first one) has 
another atom to which it is bonded (or simply defined through) and the distance to that atom. The 
same way the angle and the dihedral angle are given. Cartesian coordinate method, on the other 
hand, does not use atomic connectivity. It simply defines the position of each atom in space by 
giving the values of x, y, and z coordinates. 

The geometry of an existing molecule can be modified in MaSK through either Z-Matrix (Fig. 6.1) 
or Cartesian coordinates of atoms (Fig. 6.2). Press button to bring up a Modify geometry 
dialog. To switch between Z-Matrix and Cartesian, press the corresponding tab in the dialog. 
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Figure 6.1. Z-Matrix page of the Modify molecule dialog. 

 
Figure 6.2. Cartesian page of the Modify molecule dialog. 

The Z-Matrix of the molecule is represented using 8 columns: 1) ordinal number of the atom in a 
molecule, 2) atomic symbol, 3) bond length (in Å), 4) bond connectivity atom number, 5) angle (in 
degrees), 6) angle connectivity atom, 7) dihedral angle (in degrees), 8) dihedral angle 
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connectivity atom. The first three atoms in each molecule do not have all 8 parameters. The first 
atom in the Z-Matrix has only first two, the second one has four, and the third one has six 
columns filled. 

The Cartesian coordinates are displayed using 5 columns: 1) ordinal number of the atom in a 
molecule, 2) atomic symbol, 3) X-coordinate, 4) Y-coordinate, and 5) Z-coordinate. 

To modify any value in Z-Matrix (columns 2 through 8) or Cartesian coordinates (columns 2 
through 5), first click on the row for the atom which value you want to modify (the selected atom 
will change color to yellow in the main window) and then click on the value you want to modify. 
The field will then change to editable text box. After new value is entered, press ENTER or simply 
leave the field by clicking outside the value area to apply the change or press ESC to cancel the 
change. 

GAMESS allows to freeze some bonds/distances to perform a restricted optimization. If such 
optimization is desired, right-click the bond(s) you want to freeze and select Freeze from the pop-
up menu. The frozen distance will be colored in red. To unfreeze, right-click the value and select 
Unfreeze from the pop-up menu. 

To delete atoms, select all atoms you wish to delete by checking the boxes for those atoms and 
press the Delete selected button. If some of the deleted atoms were used as connectivity for 
other atoms, then new connectivity atoms and values will be selected automatically and the 
positions of the remaining atoms will be preserved. 

To change the order of the atoms in the molecule, press the Reorder atoms button. When the 
latter is pressed, the dialog will disappear and mouse pointer will change to cross-hair. You now 
have to click on every atom in the molecule to select them in the order you want the atoms to be 
ordered in a molecule. All selected atoms will be colored in yellow until the last atom is selected 
or reordering cancelled. After the last atom is selected or reordering is cancelled the Modify 
geometry dialog window will show up automatically and the mouse pointer will change back to 
normal. 

To add atoms or groups of atoms to the molecule, press the Add atom button (for more 
information, read the following sections Adding Atoms and Adding Groups of Atoms ). 

6.2 Adding Atoms 

There are two ways to add atoms, automatic and manual. To add atoms automatically, press 
on the Editing toolbar or press Add atom button in the Modify molecule dialog (make sure the 
checkbox for manual entry at the top of the Z-Matrix is unchecked). The Add atoms or groups of 
atoms dialog will appear (Fig. 6.3). To add atom to the molecule, press the corresponding button 
on a brief version of the periodic table or select an atom from a drop-down list and press the 
Select button next to it. After that the dialog will disappear and you will need to select an atom to 
which the selected atom will be attached (except for the first atom in the molecule, which will be 
added right away). When the atom is clicked, the new atom will be attached to it with a distance 
that depends on the Bond order selected in the dialog. The angle and dihedral angle values as 
well as the connectivity atoms will be chosen automatically and can be later modified through a 
Modify geometry dialog (see above). 
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Figure 6.3. The Atoms page of the Add atoms or groups of atoms dialog. 

Manual addition of atoms allows you to set all connectivity atoms and the values of distance, 
angle and dihedral angle manually. To add atoms manually, press Add atom button in the Modify 
molecule dialog with a checkbox for manual entry at the top of the Z-Matrix checked. The Add 
atom (Fig. 6.4) dialog will appear. 

 
Figure 6.4. The Add atoms dialog for manual atom entry. 

Depending on the current number of atoms in a molecule, some of the fields may be disabled. If 
adding the first atom in the molecule, then only the Element drop-down list will be available. If 
adding the second atom, then enter the distance in the Distance textbox and select the Atom 1 
from the drop-down list of all atoms in the molecule in addition to selecting the element being 
added. For third atom one needs to also enter the angle value and select the second atom from 
the list of all atoms in a molecule. The fourth and further atoms require all fields to be filled. Note: 
all connectivity atoms must be unique; when choosing connectivity atoms you cannot select the 
same atom more than once (you will get an error message if you do). 

6.3 Adding Groups of Atoms 

To add groups of atoms, press on the Editing toolbar or press Add atom button in the Modify 
molecule dialog (make sure the checkbox for manual entry at the top of the Z-Matrix is 
unchecked). When the Add atoms or groups of atoms dialog appears (Fig. 3), press the Groups 
tab at the top of the dialog. There are 14 pre-built functional groups available for automatic 
addition to the molecule (Fig. 6.5). 
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Figure 6.5. Add Groups page of the Add atoms or groups of atoms dialog. 

To add a group, press the corresponding button on the page. After the group is selected, the 
dialog will disappear and an atom in the molecule to which the new group will be attached should 
be selected. 

6.4 Setting GAMESS Input Options 
When GAMESS input file is initially created, it is automatically assigned default input options (see 
Fig. 6.6). To change the options, select Input Options from the Calculate menu. 
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Figure 6.6. GAMESS Input Options dialog with default options. 

The dialog contains some most frequently used options. Following are the list of available options 
for each property. 

Run type: Single-Point Energy, Geometry Optimization, Transition State, Potential Energy 
Surface. This sets the type of calculation to be performed. Geometry optimization and Transition 
State are the localizations of local minimum and saddle point (transition state), correspondingly. 

Level: Ab Initio, MNDO, AM1, PM3. The last three options are semiempirical methods. 

SCF Type: RHF, UHF, ROHF. Sets a type of self-consistent field (SCF) to Restricred Hartree-
Fock (RHF), Unrestricted Hartree-Fock (UHF), or Restricted Open-Shell Hartree-Fock (ROHF). 

Correlation: None, MP2, DFT. Sets the correlation level to none, Moller-Plesset Second Order 
Perturbation (MP2) or Density Functional Theory (DFT) level. 

DFT Type: B3LYP1, B3LYP5, BHHLYP, BLYP, LYP, BVWN5. Selects the functional for DFT 
calculations (available when DFT correlation is chosen). 

Basis set: STO-3G, 3-21G, 6-31G, 6-311G, Double-zeta valence, Triple-zeta valence. The first 
basis set is the Pople's minimal basis set. Basis sets 2-4 are the standard split-valence Pople's 
basis sets. The last two are Dunning's correlation consistent double-zeta and triple-zeta basis 
sets. Some basis sets allow to add polarization functions (on heavy and/or light atoms) and 
diffuse functions (on heavy and/or hydrogen atoms). Consult GAMESS manual to find which 
basis sets allow polarization and/or diffuse functions added to them. 
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Molecule's specifications include Multiplicity (1-5), Charge (-3...0...+3), and Symmetry Group. 

Additional calculation options include IR Vibrations and Thermodynamics (to calculate vibrational 
frequencies and various thermodynamic data) and Solvation. If solvation is chosen, then the 
solvent must also be selected. 

Finally, the input coordinates may be saved as either Cartesian coordinates or Z-Matrix. 

If the run type is set to Potential Energy Surface (PES), then additional options will be available in 
the dialog (see Fig. 6.7). In GAMESS you may build a one-dimensional PES by varying a single 
distance or two-dimensional PES by varying two distances. In the Distance #1 area select atoms 
1 and 2, between which the distance will be varied. The original distance and the final distance 
values will be automatically filled with current distance values in the molecule. Modify original or 
final distance (or both) and select the number of steps you want to be calculated on the PES. The 
step size will be automatically calculated based on your values. Repeat procedure for the 
Distance #2 if two-dimensional PES is desired (leave Distance #2 values at their defaults settings 
if only a single-dimensional PES is desired).  

 
Figure 6.7. PES options on the GAMESS Input Options dialog. 

Options presented in this dialog are only a very small subset of all options available in the PC 
GAMESS. If the option you would like to set is not available through this dialog, then you need to 
modify the input file manually (consult PC GAMESS manual for details). 

6.5 Running GAMESS Calculations 
To run GAMESS calculation from within MaSK, do the following: 
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1. Open GAMESS Input file (or convert other format into GAMESS Input). 
2. Modify GAMESS input options as described in previous section (only if needed). 
3. Select Run Calculations from the Calculate menu. 

You will then be prompted for the name of the file to which the GAMESS output will be saved. 

Note: If this is the first time you are trying to run PC GAMESS from MaSK, you will be asked to 
choose the location of the GAMESS.EXE file on your computer.  

To see if the GAMESS calculation is running, choose Show Running Calculations from the 
Calculate menu. If the calculation is running, the window will show the names of the input and 
output files. Click on Terminate button if you want to terminate the calculation. Note: the status is 
updated only when the window is first open; to update the status press the Refresh button. 

7. Saving, Printing and Copying Images 
Saving Images 

All images generated by MaSK can be saved in one of the four formats: JPEG, GIF, BMP and 
PNG. The size of the resulting graphics file can be changed in Preferences. In order to save the 
image that is currently in the main window, select option Save Image As... from the File menu. 
You will then be asked to select a name (the default name is that of the currently open file), 
location and the format for the saved graphics file.  

Printing and Copying to Clipboard 

In addition to saving the image, it can also be printed (if at least one printer is available) or copied 
to clipboard. Note: no matter what color background is currently chosen, the image will be printed 
without background (equivalent to white background if printed on white paper). In order to print, 
press the button on the Standard toolbar , select Print from the File menu or press Ctrl-P.  

To copy the image to clipboard, either press Ctrl-C or select Copy to Clipboard from the Edit 
menu. The size of the copied image and its resolution depend on the resolution of the monitor. If 
higher size/resolution is desired, then saving the image into file is recommended (see above). 

8. Exporting Cartesian Coordinates 
Cartesian coordinates of the visualized molecule can be exported into a text file for use in an 
application other than GAMESS. In order to do that, visualize the geometry you want to export 
(e.g., visualize a desired step of optimization) and then choose option Export Cartesians... from 
the File menu. You will then be able to choose the name and location of the file containing 
Cartesian coordinates. 
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9. Customizing MaSK 
There are several parameters that a user can customize in MaSK. All customizable parameters 
can be accessed by selecting a Preferences option in the Edit menu. Note: all customizations are 
user-specific, which means that every user account on the same computer will have its own 
customized options. 

The Preferences dialog has four tabs: General, Visualization, Atoms, and Bonds. Following 
sections contain the description of the options available on each page in the Preferences dialog. 

9.1 General 
Use this page (Fig. 9.1) to change the size of the on-screen text, color of the text and 
background, maximum resolution of the saved images, and options to save calculated molecular 
orbital data (cube) to disk and whether to start from the initial or final geometry when opening an 
output with multiple geometries. 

 
Figure 9.1. General page of the Preferences dialog. 

The Text size option controls the size of the on-screen text used for displaying atomic labels, 
charges, as well as measured parameters such as distance, angle, etc. The size range is from 9 
to 36 pts. 

The color boxes for the text color and background color display the currently selected colors and 
the corresponding RGB values are displayed in the curled brackets. Text color and background 
color can be changed by clicking on the corresponding color box, which will bring up a color 
dialog. 
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The maximum size/resolution of the saved image (in MegaPixels, or MP) can be set by choosing 
a size from a Maximum resolution drop-down menu. Available options include 1, 2.5, 5, 10, and 
20 MP. The size is defined as the product of picture's height and width in pixels. Note: this setting 
sets the approximate size of the picture; the actual size of the picture will vary depending on the 
proportions of the program window. 

When building surfaces such as molecular orbitals and electron density , a large amount of data 
is being calculated. In order for the MaSK to not recompute those values each time the desired 
surface is visualized, the calculated data (cube data) can be saved to file. Is this option is 
selected, each time a surface is calculated the values will be saved to a MaSK Cube file, which 
will have the same name as the currently open output file with an .mcu file extension. In addition, 
when this option is selected, each time a surface is being built the MaSK will check if this surface 
has been previously calculated and save into MaSK Cube file. If found, the data will be loaded 
from file and no additional calculations will be performed.  

Note: the more surfaces are saved into a MaSK Cube file, the more time it takes to search for a 
particular cube data in this file. Therefore, it is recommended to turn this option off when 
visualizing a large number of surfaces for the same molecule, especially if the molecule and/or 
the basis set are small (in other words, when calculations are faster than file reading).  

When MaSK opens an output file with multiple geometries (i.e., geometry optimization, saddle 
point localization, IRC, etc.), either first or last geometry will be displayed depending on the option 
chosen by the user. The default setting is to display the initial geometry. To change the starting 
geometry to final, choose the Final (Optimized) option for the Starting Geometry setting. 

9.2 Visualization 
The Visualization page (Fig. 9.2) allows to set options for drawing bonds between two metals and 
between metals and nonmetals, as well as change the rates of rotation, vibration, and animation. 
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Figure 9.2. Visualization page of the Preferences dialog. 

To change any of the three rates, move the slider towards Slow (for slower rate) or towards Fast 
(for faster rate). 

The rate of Rotation controls how fast the molecule will be rotated when left button of a mouse is 
pressed while in regular mouse mode (not Hold & Pull mouse). The rate of Vibration controls how 
fast the atoms will be shifted while the molecular vibrational modes are displayed. Finally, the rate 
of Animation determines how long each step will be displayed in multiple-geometry outputs when 
the Animate button is pressed. Faster setting means shorter duration for each step.  

9.3 Atoms 
The Atoms page (Fig. 9.3) allows to change some atomic parameters such as atomic radius, Van 
der Waals radius and color. 
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Figure 9.3. Atoms page of the Preferences dialog. 

Atomic radius determines the radius of the balls in the Balls and Sticks visualization mode. The 
radii of the balls for all atoms except hydrogen in this mode scaled to 60% of the atomic radii. The 
radius of the hydrogen atom is set to 72% of the hydrogen's atomic radius. 

Van der Waals radius determines the radius of the sphere representing atom in the Spheres 
visualization mode. Van der Waals radii are not scaled. 

Note: In addition to determining the radii of the balls on the screen, the atomic radius is also used 
in determining whether a bond exists between two atoms. The bond is drawn if the distance 
between atoms is less than 125% of the sum of their atomic radii.  

Each atom's color can be changed by left-clicking on the color box and selecting a new color. The 
color shown in the color box represents the currently set color for a selected atom. 

To change any values for a particular atom, first select a desired atom from a drop-down list, 
change the values of radii and/or color and then press Apply (or OK) button. To reset all 
customized values for all atoms to their default values, press Reset All button. 

 

9.4 Bonds 
The Bonds page (Fig. 9.4) allows to change the values of the covalent and hydrogen bond radii 
as well as their color and opacity (for hydrogen bonds only). 
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Figure 9.4. Bonds page of the Preferences dialog. 

There are two covalent bond radii present on this page. The first one determines the radius of the 
bond in the Balls and Sticks visualization mode, while the second one is for the Tubes mode. The 
default value of the bond radius in Balls and Sticks model is 0.14Å, which is approximately 80% 
of the default radius of the ball representing hydrogen atom. The default value of the bond radius 
in Tubes model is 0.9Å, which is approximately 50% of the default radius of the ball representing 
hydrogen atom. 

The hydrogen bond radius is set by default to 0.04Å, which is approximately 20% of the default 
radius of the ball representing hydrogen atom. 

The hydrogen bond opacity determines how opaque the hydrogen bond will look on the screen. 
The values range from Min (completely transparent) to Max (completely opaque). 

The colors of covalent bonds currently selected are displayed in the corresponding color boxes. 
To change the color, click on the box and select a new color. 
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